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RISCO DE CHOQUES 
ELÉTRICOS, NÃO ABRA

A T E N Ç Ã O :

ADVERTÊNCIA:PARA REDUZIR O RISCO DE INCÊNDIO E CHOQUE 

CUIDADO

ELÉTRICO, NÃO EXPONHA ESTE APARELHO À CHUVA OU UMIDADE

INSTRUÇÕES IMPORTANTES DE SEGURANÇA

Os símbolos mostrados acima são símbolos internacionalmente aceitos que 
advertem sobre potenciais riscos com produtos elétricos. O raio com ponta 
de flecha em um triângulo equilátero significa que há tensões perigosas 
presentes dentro da unidade. O ponto de exclamação em um triângulo 
eqüilátero indica que é necessário que o usuário consulte o guia do usuário.

Os símbolos de advertência alertam o usuário que não há partes reparáveis 
dentro da unidade. Não abra a unidade. Não tente reparar a unidade. 
Solicite todos os reparos somente à Assistência Técnica Autorizada. A 
abertura do chassi, por qualquer motivo, anulará a garantia do fabricante. 
Não molhe a unidade. Caso um líquido seja derramado sobre o aparelho, 
desligue-o imediatamente e leve-o a um distribuidor para reparação. 
Desligue o aparelho durante tempestades para evitar danos.

INSTRUÇÕES DE SEGURANÇA

SIGA TODAS AS INSTRUÇÕES

�
AVISO PARA OS CLIENTES QUE POSSUEM UNIDADES EQUIPADA SCOM 
CABO DE ALIMENTAÇÃO.

ADVERTÊNCIA: ESTE APARELHO DEVERÁ SER CONECTADO A UMA TOMADA 
DE ENERGIA COM UM CONDUTOR DE PROTEÇÃO INTACTO.

Os cabos dentro da alimentação são coloridos, de acordo com o código 
a seguir,

VERDE e AMARELO - Terra	 AZUL - Neutro	 MARROM - Positivo

Como as cores dos cabos de alimentação deste aparelho podem não cor-
responder às marcas coloridas que identificam os terminais de sua tomada, 
proceda da seguinte forma:

• �O núcleo, que é verde e amarelo deve ser conectado ao terminal 
identificado com a letra E, com o símbolo da terra, ou de cor verde ou 
verde e amarelo.

• �O núcleo, que é de cor azul, deve ser ligado ao terminal marcado com 
N ou de cor preta.

• �O núcleo, que é de cor marrom, deve ser ligado ao terminal marcado 
com L ou de cor vermelha.

Este equipamento pode requerer o uso de cabos de cores diferentes, 
plugues de conexão ou ambos, dependendo da fonte de alimentação no 
local da instalação. Se o plugue de conexão precisar ser trocado, consulte o 
pessoal qualificado para o serviço, que deverá consultar a tabela abaixo. O 
fio verde/amarelo deve ser conectado diretamente no chassi da unidade.

AVISO: PARA SUA PROTEÇÃO LEIA  
O SEGUINTE:

GUARDE ESTAS INSTRUÇÕES

PRESTE ATENÇÃO NOS AVISOS

SIGA TODAS AS INSTRUÇÕES

O APARELHO NÃO DEVE SER EXPOSTO A GORDURA OU LÍQUIDO E  NE-
NHUM OBJETO COM LÍQUIDO, TAL COMO VASOS, DEVEM SER COLOCADOS 
SOBRE O APARELHO.

LIMPE APENAS COM UM PANO SECO

NÃO BLOQUEIE AS ENTRADAS DE VENTILAÇÃO. INSTALE O EQUIPAMENTO 
DE ACORDO COM AS INSTRUÇÕES DO FABRICANTE.

NÃO INSTALE A APARELHO PRÓXIMO A QUALQUER FONTE DE CALOR, 
COMO RADIADORES, REGISTROS DE CALOR, FORNOS OU OUTROS EQUIPA-
MENTOS (INCLUSIVE AMPLIFICADORES) QUE PRODUZAM CALOR.

UTILIZE SOMENTE CONEXÕES/ACESSÓRIOS ESPECIFICADOS PELO FABRICANTE.

DESCONECTE O EQUIPAMENTO DURANTE TEMPESTADES COM RAIOS 
OU QUANDO NÃO FOR UTILIZADA DURANTE LONGOS PERÍODOS DE TEMPO.

Não anule a segurança do plugue polarizado ou do tipo 
terra. Um plugue polarizado possui duas hastes, uma mais 
larga que a outra. Um plugue do tipo com aterramento 
possui duas hastes e um pino de aterramento. A lâmina 
larga ou o terceiro pino são fornecidos para sua segurança. 
Se o plugue fornecido não encaixar na sua tomada, con-
sulte um eletricista para a substituição da tomada obsoleta.

Proteja o cabo de alimentação para que este não 
seja pisado ou preso, particularmente nos conecto-
res, nos receptáculos de conveniência, ou no ponto 
onde eles saem do equipamento.

Utilize somente o carrinho, bancada, tripé, suporte ou 
mesa especificado pelo fabricante ou vendidos com o 
equipamento. Quando um carrinho for utilizado, tenha 
cuidado quando mover a combinação rack/aparelho.

Solicite todos os reparos somente à Assistência Técnica 
Autorizada. A Assistência técnica é necessária quando a 
filmadora tiver sido danificada de qualquer forma, como, 
por exemplo, se o cabo/plugue de energia for danificado, 
líquido tiver respingado ou objetos tiverem caído dentro 
da filmadora, se a filmadora tiver sido exposta à chuva 
ou umidade, não funcionar normalmente, ou tiver sofrido 
uma queda.

INTERRUPTOR LIGA/DESLIGA: O interruptor de ali-
mentação usado neste equipamento não quebra a ligação 
da rede elétrica.

DESCONEXÃO DA ALIMENTAÇÃO: O plugue deve 
permanecer sempre operacional. Para montagem em rack 
ou instalação onde a tomada não é acessível, um interrup-
tor de corrente de todos os pólos com uma separação 
de contato de pelo menos 3 mm em cada pólo será 
incorporado à instalação elétrica do rack ou edifício.

PARA UNIDADES EQUIPADAS COM RECEPTÁCULO 
DE FUSÍVEL ACESSÍVEL EXTERNAMENTE: Substitua o 
fusível apenas por outro com as mesmas especificações.

ENTRADA DE VOLTAGEM MÚLTIPLA: Este equipamen-
to pode exigir a utilização de um cabo de linha diferente, 
plugue, ou ambos, dependendo da fonte de energia dis-
ponível na instalação. Conecte este equipamento somente 
na fonte de alimentação com as especificações indicadas 
no painel traseiro do equipamento. Para reduzir o risco 
de incêndio ou choque elétrico, recorra aos serviços de 
pessoal qualificado ou equivalente.

Se ligado a uma alimentação de 240v, um cabo de alimenta-
ção CSA/UL certificado deve ser utilizado para esta fonte.

ADVERTÊNCIA: Se o aterramento não for usado, podem ocorrer certas 
condições de falha na unidade ou no sistema ao qual está conectado, 
podendo ocorrer a transmissão da tensão total entre o chassi e o ater-
ramento. Podem ocorrer ferimentos graves, ou mesmo levar à morte, se o 
chassi e fio terra forem tocados simultaneamente.

ADVERTÊNCIA DOS PRINCIPAIS  
PLUGUES DO R.U.

Um plugue de rede que teve seu cabo retirado não é seguro. Descarte 

o plugue de alimentação em uma instalação apropriada para este 

fim. NUNCA, SOB NENHUMA CIRCUNSTÂNCIA, VOCÊ DEVE INSERIR 

UM PLUGUE DANIFICADO OU CORTADO EM UMA TOMADA DE REDE 

DE 13 AMP. Não use o plugue de alimentação sem que a tampa do 

fusível esteja instalada. Tampas para os fusíveis substituídos podem 

ser obtidos no revendedor local. Os fusíveis de substituição são de 13 

ampéres e DEVEM ter aprovação ASTA para BS1362.

CONDUTOR
COR DO FIO

Normal: � Alt

L POSITIVO MARROM PRETO

N NEUTRO AZUL BRANCO

E TERRA (GND) VERDE/AMARELO VERDE

Estes produtos podem sofrer alterações sem aviso prévio.
Todas as figuras neste manual são meramente ilustrativas.

                                           Cód.: 207494  Rev.: 01 - 10/11



INSTRUÇÕES IMPORTANTES DE SEGURANÇA

DECLARAÇÃO DE CONFORMIDADE
Nome do Fabricante:	 Lexicon Professional
Endereço do Fabricante:	 8760 S. Sandy Parkway 
	 Sandy, Utah 84070, EUA

declara que o produto:

Nome do produto:	 Lexicon IO 22

Opção de produto:	� todos (requer adaptador de energia Classe II em conformidade com os requisitos  
da EN60065, EN60742, ou equivalente.)

de acordo com as seguintes especificações do produto:

	 Segurança:	 IEC 60065 -01+Amd 1

	 EMC:	 EN 55022:2006
	 EN 55024:1998 
	 FCC Parte 15

Informação Complementar:

	 O produto está em conformidade com os requisitos da:
	 Diretiva de Baixa Voltagem 2006/95/EC
	 Diretiva EMC 2004/108/EC.
	 Diretiva RoHS 2002/95/EC
	 Diretiva RoHS 2002/96/EC

	� Nos termos da Diretiva 2005/32/CE e do Regulamento CE 1275/2008 de 17 de Dezembro de 2008, este produto foi 
concebido, produzido e classificado como um equipamento de áudio profissional e, portanto, está isento da presente diretiva.

	� Nos termos da Diretiva 2005/32/CE e do Regulamento CE 278/2009 de 06 de abril de 2009, este regulamento aplica-se 
às fontes de alimentação externas (de saída única) Classe A. A fonte de alimentação externa com este produto é uma fonte 
de multissaída de energia e, portanto, está isenta da presente diretiva.

	� Roger Johnsen
	 Diretor, Engenharia de Processamento de Sinal S. 
	 Sandy Parkway
	 Sandy, Utah 84070, EUA
	 Data: 23 de Fevereiro de 2011

Contato na Europa: Seu local de Vendas e Escritório de Serviços Lexicon ou

	 Harman Signal Processing 
	 8760 South Sandy Parkway 
	 Sandy, Utah 
	 84070 EUA 
	 Ph: (801) 566-8800 
	 Fax: (801) 568-7583

COMPATIBILIDADE ELETROMAGNÉTICA

Este dispositivo está em conformidade com a parte 15 das Normas da FCC e das Especificações do Produto especificadas 
na Declaração de Conformidade. A operação está sujeita às duas seguintes condições:

• este dispositivo não poderá causar interferências nocivas, e
• �este dispositivo deve aceitar qualquer interferência recebida, incluindo interferências que possam causar operação 

indesejada.

A operação desta unidade dentro de campos eletromagnéticos significativos deve ser evitada.

• use apenas cabos de interconexão blindados.

Caso queira descartar este produto, não o misture com o lixo doméstico comum. Existe um 
sistema de coleta de lixo especial para produtos eletrônicos usados, de acordo com a legislação, 
que requer o tratamento apropriado, coleta e reciclagem. 

Os proprietários particulares nos 25 estados membros da União Europeia, na Suíça e na Noruega, podem re-
tornar seus produtos eletrônicos usados, sem qualquer encargo, nas estações de coleta ou nos revendedores 
(se você comprar um produto similar).

Para os outros países, não mencionados acima, favor entrar em contato com as autoridades locais para 
se informar sobre os métodos de descarte corretos. Ao agir desta maneira, você estará garantindo que o 
produto descartado receberá o tratamento, recuperação e reciclagem necessários, prevenindo, assim, os 
danos potenciais para o meio ambiente e para saúde humana.



Índice
INTRODUÇÃO 1

Características 1

Desembale seu Gravador de Desktop IO22

Interface 2

Os itens a seguir estão inclusos: 2

Requerimentos do Sistema 2

PAINEL DIANTEIRO 3

PAINÉIS LATERAL E TRASEIRO 5

CONECTANDO O IO 22 7

Microfones 7

Fontes de Nível de Linha 7

Instrumentos 7

Computador/Estação de Áudio Digital (DAW) 7

Fones de ouvido 7

Alto-falantes do Monitor 7

Exemplo de Conexões 8

IO 22 PROJETO DE EXEMPLO –  
GRAVANDO UMA GUITARRA

 
9

Instalação de Drivers, Software de Controle e  
Cubase® LE 

 
9

Ativação de Cubase LE 9

Configuração do Windows® Audio e 
MIDI (Opcional)

 
10

Conexões do Exemplo de Projeto 10

Conectando uma Guitarra 11

Conectando o Computador 13

Ouvindo a Entrada da Guitarra (Direto) 13

Configuração do Cubase® LE para Uso com o IO 22 
(Windows®)

 
14

Configuração do Cubase® LE para Uso com o IO 22 
(Mac®)

 
15

Gravando uma Faixa no Cubase® LE 16

Criando um Novo Projeto 16

Iniciando a Gravação 17

Ouvindo a Gravação 17

Mixagem de Áudio 18

Opções e Características do Cubase LE 18

Usando a Reverberação Pantheon II no Cubase LE 18

DIAGRAMA DE BLOCO 19

ESPECIFICAÇÕES 20



1

Introdução
Parabéns e obrigado por adquirir a interface de gravação de mesa Lexicon® 
IO 22!

A patente pendente IO 22 se encaixa onde faz mais sentido, entre o teclado e 
o monitor. Com todas as métricas de nível e controles de ganho na ponta dos 
dedos, você se perguntará por que ninguém pensou nisso antes.

Apresentando o novo design dbx® 60V de alta tensão, ruído ultrabaixo do mi-
crofone em cada canal, o IO 22 é mais do que preparado para fornecer grava-
ções profissionais que fazem a sua música soar melhor. Os pré-amplificadores 
são executados em uma fonte de 60V para garantir a estabilidade e fornecer 
uma gravação superior em uma ampla faixa dinâmica. O desempenho impul-
sionado dos conversores A/D – D/A garantem 24bit/96kHz de áudio para 
capturar todos os detalhes sutis da sua performance.

O nome do Lexicon é sinônimo de “melhor reverberação do mundo.” O plug-in 
de reverberação Pantheon ™ II VST/AU possui 6 tipos de reverberação com 
16 parâmetros ajustáveis, e 35 pré-ajustes de fábrica que vão desde Vocal até 
Som ao Vivo e Efeitos Especiais. É fácil de concluir a sua mixagem e fazer sua 
música soar melhor com a requintada, completa reverberação que tornou a 
Lexicon famosa.

Características
• alta voltagem dbx®, ruído ultrabaixo do microfone

• 2 conectores analógicos para microfone/linha

• 1 painel lateral de entrada de instrumento

• 2 saídas analógicas TRS 

• 1 saída de fone com controle de volume

• Entrada e saída de MIDI 

• Interface de áudio USB 2.0

• Taxas de amostragem de 44,1 a 96KHz, conversão de 24 bit
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Desembale seu Gravador de Desktop IO 22
Cada interface de gravação desktop IO 22 é enviada em uma caixa, contendo 
a unidade IO 22 e um DVD de software para sistemas Windows® e 
Macintosh®. Depois de desempacotar, guarde todos os materiais de embala-
gem no caso de você ter que transportar a unidade. Inspecione completamente 
a unidade IO 42 e os materiais de embalagem para sinais de danos. Relate 
quaisquer danos de embarque para a transportadora que entregou o produto 
ou o fornecedor de quem adquiriu o produto.

OS SEGUINTES ITENS ESTÃO INCLUÍDOS:

• Interface de Gravação para Desktop IO 22 

• �DVD de instalação contendo drivers, este manual, o plug-in de reverbação 
Lexicon Pantheon II, o plug-in XILS3 SE, o software de gravação Cubase 
LE, e o ToonTrack® EZDrummer Lite para Mac® e Windows®

• Cabo USB

• Registro de garantia Lexicon Professional
• Fonte de alimentação

NOTA: O manual completo do Cubase LE está localizado no DVD de 
software.

Requisitos do Sistema
Um poderoso software para gravação de áudio exige um computador potente 
com o software do sistema operacional, processador e memória. A maioria dos 
computadores vendidos atualmente já atende a esses requisitos, ou pode ser 
atualizada para ser compatível com o IO 22. Tal como acontece com todos 
esses sistemas, adicionar mais RAM do que o mínimo vai permitir com que 
você faça mais processamento e melhorar o desempenho.

Windows® Vista, XP, 7 (Requerimentos Mínimos do Sistema)

• Processador de múltiplos núcleos

• 1GB RAM

• Resolução de Tela de 1024 x 768 pixels

• Drive de DVD-ROM 

• Acesso à Internet necessário para ativação de licença de software

Mac® (Requisitos Mínimos do Sistema)

• Processador Intel® 

• 1 GB RAM

• Versão OS X 10.4.9 ou superior

• Resolução de Tela de 1024 x 768 pixels

• Drive de DVD-ROM 

• Acesso à Internet necessário para ativação de licença de software

Nota: O Adobe Reader é necessário para visualizar os documentos PDF no 
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1 2

3 4 5 6 7 8 9 10 11

Painel Dianteiro

1. LEDS DE NÍVEL DE ENTRADA

Indicam o nível de sinal para cada entrada, mostrando o headroom restante 
antes do clipping. Seus valores são: Corte Vermelho
Vermelho	 Corte
Amarelo	 –3dB
Verde	 –6dB
Verde	 –9dB
Verde	 –12dB
Verde	 –18dB
Verde	 –24dB
Verde	 –30dB

2. LEDS DO NÍVEL DE SAÍDA

Esse 'sinal indica o nível para cada saída ao exibir o headroom restante antes 
de cortar. Os valores são:
Vermelho	 Corte
Amarelo	 –3dB
Verde	 –6dB
Verde	 –9dB
Verde	 –12dB
Verde	 –18dB
Verde	 –24dB
Verde	 –30dB

3. BOTÃO DO NÍVEL DOS FONES

Ajuste o nível do sinal de saída do fone de ouvido aqui.

4. BOTÃO DE GANHO MIC/LINHA/INST 1 

Ajuste o nível de entrada de ganho para Mic/Linha 1 ou Instrumento 1.
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5. LED DO INSTRUMENTO
Acende quando um plugue de 1/4" é inserido no conector do Instrumento no 
painel lateral direito.

6. BOTÃO ESTÉREO E LED ESTÉREO
Esse botão alterna entre os modos Estéreo e Mono para a entrada do Mic/
Linha 1 (ou entrada do Instrumento) e entrada Mic/Linha 2. O LED acende 
cada vez que o modo Estéreo é ativado.
No Modo Estéreo (LED Estéreo ligado), os sinais de entrada do Instrumento 
e Mic/Linha 1 são enviados para a Saída da Esquerda Principal, enquanto o 
sinal de entrada do Mic/Linha 2 é enviado para a Saída Principal da Direita.
Em Modo Mono (LED Estéreo desligado), cada par de entradas de sinais é 
misturado e enviado para as Saídas Principais da Esquerda e da Direita como 
um sinal mono. Um par inclui Instrumento ou Mic/Linha 1 e Mic Linha 2.
Isso não afeta o sinal que é enviado para o computador.

7. LED 48V
Acende quando a energia fantasma está ativa para o par de entradas Mic/
Linha 1 e 2. A energia fantasma pode ser ligada para o par de entradas de 
conectores pelos botões 48V no painel traseiro. Os microfones dinâmicos não 
necessitam de alimentação fantasma para funcionar. Os microfones dinâmicos 
não necessitam de alimentação fantasma para funcionar. Se você está inseguro 
sobre os requisitos de alimentação fantasma para o seu microfone, consulte a 
documentação do seu microfone ou contate o fabricante.

8. BOTÃO DE GANHO MIC/LINHA 2 
Ajuste o nível de entrada de ganho para Mic/Linha 2.

9. BOTÃO DE NÍVEL DE SAÍDA
Controla o nível de saída esquerda e direita principais.

10. BOTÃO DE MIX DO MONITOR
A unidade IO 22 dá-lhe a capacidade de ouvir seus sinais de entrada analógica 
direta e imediatamente durante a gravação sem ter que ajustar os níveis de 
software e antes do atraso causado por conversores digitais e latência da grava-
ção de computador. Esse monitoramento analógico de latência zero é contro-
lado pelo botão Mix Monitor, que você pode usar para ajustar a mistura entre 
as entradas analógicas ao vivo (chamadas "Diretas") e todos os sons vindos do 
computador via USB ("Reprodução"). Para ouvir apenas os sinais de entrada 
ao vivo de fonte ligada ao IO 22, gire o botão Mix totalmente para a esquerda 
para a Direta. Para ouvir somente o mix do computador, gire o botão Mix 
totalmente para a direita para Reprodução. A saída do controle Mix Monitor 
é encaminhada para as saídas principais e o resultado é ouvido nos fones de 
ouvido.

11. LED USB 
Acende-se quando uma conexão USB é detectada.
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1 32 4 5 6 7 8 9

Painéis Lateral e Traseiro

1. ENTRADA DO INSTRUMENTO
Essa entrada não balanceada aceita um conector de 1/4"  e suporta fontes de 
níveis de instrumentos (incluindo guitarras). Note que quando a entrada do 
Instrumento está conectada, a entrada Mic/Linha 1 é desabilitada.

2. INTERRUPTOR “POWER” (ENERGIA)
Liga e desliga o IO 22.

3. CONECTOR “POWER” (ENERGIA)
Utilize somente a fonte de alimentação fornecida (veja as especificações para 
mais detalhes).

4. PORTA USB
A porta USB é usada para conectar o IO 22 no seu computador. Um cabo 
USB padrão é incluído. O IO 22 só é compatível com USB 2.0.

5. ENTRADA E SAÍDA DE MIDI
As tomadas de MIDI fornecem entrada e saída MIDI para o seu computador. 
Ligue o seu teclado MIDI, módulos de som e controladores externos aqui.

6. Saídas “MAIN” (Principal)
Essas saídas suportam conexões TRS balanceadas ou TS ¼" desbalanceadas. 
Estas saídas podem ser conectadas a uma mesa de mixagem, amplificador de 
potência, monitores de estúdio, gravador, ou outra entrada de nível de linha. 
Utilize cabos balanceados para essas conexões. Quando ligar o equipamento 
equilibrado a outro, use cabos balanceados para melhor desempenho.

7. ENTRADAS MICROFONE/LINHA 1-2
Estas entradas balanceadas aceitam XLR ou conectores de 1/4 " e suportam 
microfones e fontes de nível de linha. Note que quando a entrada do Instru-
mento está conectada, a entrada Mic/Linha 1 é desabilitada.



6

8. BOTÃO “PHANTOM POWER 48V” (ENERGIA FANTASMA 48V) – MIC/
LINHA 1 E MIC/LINHA 2
Isso disponibiliza a energia fantasma para as entradas de Mic/linha 1 e Mic/
Linha 2. Quando ligada, o LED +48V entre os botões Mic/Line/Inst Gain  
(Mic/Linha/GanhoInst) 1 e 2 se acendem no painel frontal. Os microfones 
dinâmicos não necessitam de alimentação fantasma para funcionar. Os micro-
fones dinâmicos não necessitam de alimentação fantasma para funcionar. Se 
você está inseguro sobre os requisitos de alimentação fantasma para o seu mi-
crofone, consulte a documentação do seu microfone ou contate o fabricante. 
Essa opção deve ser desativada se você estiver conectando qualquer fonte de 
nível de linha na entrada do Microfone.

9. CONECTOR DE FONE
A saída de Fone aceita fones estéreos com plugues estéreo de 1/4”. Essa saída 
é a mesma das enviadas nas Main Outputs (Saídas Principais), mas com con-
trole independente de nível. 
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Conectando o IO 22
Microfones
Plugue um cabo XLR diretamente de um microfone em uma entrada de Mic/
Inst desejada no painel traseiro do IO 22.

Se o microfone exige alimentação fantasma, primeiro certifique-se de que 
o microfone esteja ligado e pressione o botão de +48 V/LED para o par de 
entrada correspondente no painel traseiro. Se o seu microfone não precisa de 
alimentação fantasma, o melhor é deixá-lo desligado.

Nota: Alguns microfones podem ser danificados pela alimentação fantasma 
+48 V. Consulte a documentação do microfone antes de ativar a alimentação 
fantasma +48 V.

Fontes de Nível de Linha
Fontes de nível de linha incluem teclados, baterias, CD players e pré-amplifi-
cadores de microfone externos, processadores de efeitos e de guitarra. Plugue 
um cabo 1/4" TS (desbalanceado) ou TRS (balanceado) diretamente de uma 
fonte de nível de linha na entrada Mic/Inst desejada no painel traseiro do IO 
22. Para evitar ruídos utilize cabos balanceados ao conectar fontes de nível de 
linha balanceadas.

Instrumentos
O conector Instrumento no painel lateral direito aceita sinais de instrumen-
tos como guitarras e baixos. Plugue um cabo 1/4" TS padrão (instrumento) 
desbalanceado diretamente do instrumento no conector de entrada do Instru-
mento no painel lateral direito do IO 22. Observe que quando a entrada do 
Instrumento está conectada, a entrada Mic/Linha 1 é desabilitada.

Computador/Estação de Trabalho de Áudio Digital 
(DAW)
Conecte a porta USB do seu computador à porta USB no painel traseiro do 
IO 22 usando um cabo USB 2.0 padrão (incluído).

Fones de ouvido
Conecte os fones no conector de Fones localizado no painel lateral esquerdo. 
O conector de Fone aceita conectores 1/4" TRS. Ajuste o volume dos fones 
com o botão “Phones Level” (Nível dos Fones).

Alto-falantes do Monitor
Usando cabos, ligue os conectores de saída principais L/R no painel traseiro 
nas entradas apropriadas no seu mixer, amplificador de potência, ou monitore 
ativos. Ajuste o volume de saída com o botão Nível de saída. Quando ligar o 
equipamento equilibrado a outro, use cabos balanceados para melhor desem-
penho.
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USB Cable

 

Exemplo de Conexões

Microfone

PC ou Mac

Cabo USB
Monitor

Entrada MIDI

Saída do fone 
 de ouvido

Instrumento

Alto-falantes potentes

Teclado

Fones de ouvido
Cabo do Instrumento

Saída MIDI
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eLicense Number
(20 characters)

Activation code
(32 characters)

Exemplo de Projeto IO 22 – Gravando o Som 
de uma Guitarra
Siga os passos neste exemplo para começar a usar o IO 22 e se familiarizar 
com ele. Este exemplo usa o Cubase® LE, mas o IO 22 funciona com diver-
sas aplicações DAW.

Instalação de Drivers, Software de Controle e Cubase® LE
	 1.	� Insira o DVD no seu drive do DVD-ROM. A Instalação deve iniciar 

automaticamente.

		�  Se o instalador não iniciar automaticamente, você poderá iniciá-lo 
manualmente abrindo o arquivo apropriado no DVD:

		  Mac®: 	 “Open Me” (Abra-me)
		  Windows®: 	InstallationMenu.exe

	 2.	� Uma vez que a Instalação inicie, siga as instruções na tela para instalar o 
software que você deseja usar.

		�  Nota: Você deve instalar os Drivers IO 22 para usar o IO 22 com  
Cubase® LE. Você também deve instalar o Cubase LE para seguir os 
passos do projeto de exemplo nas páginas seguintes.

		�  O download dos drivers IO 22 mais atuais também pode ser feito no 
www.lexiconpro. com.

Cubase LE Ativado
	 1.	 Instale o Cubase LE.
	 2.	� Inicie o Cubase LE e clique no botão 'Register Now' (Registrar Agora) 

ou vá para o site www.steinberg.net/en/mysteinberg
	 3.	� Crie uma conta MySteinberg (siga as instruções da tela) e entre no  

MySteinberg.
	 4.	� Clique na sua versão do Cubase LE na seção Activation & Reactivation 

(Ativação e Reativação) e, depois, clique em 'More' (Mais) na seção 
Permanent Activation (Ativação Permanente).

	 5.	� Digite o seu Número de Licença (N° Sel). Este número pode ser encon-
trado no Centro de Controle eLicenser nos seguintes locais:  
Windows: Start > All Programs > Syncrosoft > eLicenser Control 
Center (Iniciar> Todos os Programas > Syncrosoft > eLicenser Control 
Center). 
Mac: Applications > eLicenser Control Center (Aplicações>eLicenser 
Control Center).

	 6.	� Selecione Lexicon no campo Hardware Manufacturer (Fabricante de 
Hardware) e clique em 'RequestActivation Code' (Solicitação de Código 
de Ativação).

	 7.	 Copie seu código de Aativação.
	 8.	� Volte para a janela eLicenser Control Center (Centro de Controle 

eLicenser) (a partir do passo 5) e clique em 'Enter Activation Code' 
(Introduzir Código de Ativação).

	 9.	� Digite seu código de ativação, clique em 'Continue' (Continuar), e 
depois clique em 'Download License' (Fazer Download de Licença).

	 10.	Uma vez que a licença tenha sido baixada, clique em 'Close' (Fechar).
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USB Cable

Configuração do Windows® Audio e MIDI (Opcional)
Quando os drivers e software de controle foram instalados, o Windows pode 
ter selecionado automaticamente como o seu padrão de áudio e saídas MIDI. 
Isto significa que os sons do Windows serão enviados para o IO 22, em vez do 
cartão de som do computador. Precisamos verificar se este padrão foi alterado 
e retornar às configurações anteriores.
1. �Selecione Iniciar>Painel de Controle>Som e Dispositivos de Áudio 

(XP) ou Hardware e Som (Vista/7).
2. �Selecione a aba Audio (XP) (Áudio (XP)) ou Manage Audio Devices 

(Vista/7) (Gerenciar Dispositivos de Áudio (Vista/7)).
3. �No dispositivo Som Playback>Padrão (XP), ou Playback (Vista/7), 

certifique-se de que cartão de som do computador esteja selecionado como 
dispositivo padrão.

4. �No dispositivo Gravação de Som>Padrão (XP), ou Gravação (Vista/7), 
certifique-se de que cartão de som do computador esteja selecionado como 
dispositivo padrão. 

5. �No dispositivo MIDI Música Playback>Padrão, abra o menu suspenso 
e certifique-se de que o Microsoft GS Wavetable Synth esteja selecionado 
como dispositivo padrão (somente para o XP).

Conexões do Exemplo de Projeto

PC ou Mac

Cabo USB

Monitor

Saída do fone 
 de ouvido

Instrumento

Fones de ouvido
Cabo do Instrumento
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 Botão Microfone/Linha/Instrumento 1

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 Instrumento1 entrada

 

Conectando uma Guitarra
1. Gire o botão Mic/Line/Inst 1 completamente.

2. Conecte sua guitarra na entrada Instrumento 1 no lado direito do painel.
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 Botão Fones 1

 
 
 
 
 
 
 
 
 
 
 
 
 
 Entrada “Phones 1” (Fones 1)

Conectando os fones de ouvido
1. Gire o botão Fones 1 completamente.

2. �Conecte seus fones de ouvido ao conector Fones 1 no painel do lado 
esquerdo.
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USB Cable

Conectando o Computador
Conecte a porta USB do seu computador à porta USB no painel traseiro do 
IO 22 usando um cabo USB 2.0 padrão (incluído).

Ouvindo o Som de Entrada da Guitarra (Direto)
1. Coloque os fones de ouvido
2. �Defina o mix do monitor como 12:00. Isso permitirá que você ouça uma 

mistura igual de sinais entrando no IO 22, bem como sinais os provenien-
tes do Cubase.

3. �Toque a guitarra e aumente o nível de linha de entrada até ver um sinal no 
medidor de entrada de linha 1.

4. �Gradualmente, aumente o botão Fone 1 até chegar a um nível de audição 
confortável.

PC ou Mac

Cabo USB

Monitor
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Configuração do Cubase® LE para uso com o IO 22 
(Windows®)
1. �Verifique se o cabo USB incluído está conectado ao computador e ao IO 22 

e se o IO 22 está ligado.

2. Inicie o Cubase® LE (no menu “Start” [Iniciar] no Lexicon®).

3. Se você visualizar o aviso mostrado abaixo, clique em OK.

4. �Quando estiver no Cubase LE, vá para Devices>Device Setup 
(Dispositivos>Configuração de Dispositivo).

5. �Em Dispositivos, clique em VST Audio System (Sistema de Áudio VST) e 
selecione Lexicon IO 22 no menu suspenso do driver ASIO, se já não es-
tiver selecionado. Clique em Alternar para alternar o driver, clique em OK 
na caixa de diálogo Device Setup (Configuração de Dispositivo) Agora você 
está pronto para começar a gravar usando seu IO 22 e Cubase LE.

Nota: Em muitos casos você pode melhorar o desempenho ao selecionar uma 
configuração de latência maior no menu suspenso do “System Performance” 
(Desempenho do Sistema) no painel de controle ASIO (Devices > Device 
Setup > Lexicon IO 22 > Control Panel > ASIO) [Dispositivos > Configurar 
Dispositivos> Lexicon IO 22 > Painel de Controle> ASIO].
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PC ou Mac

Cabo USB

Configuração do Cubase® LE para Uso com IO 22 
(Mac®)
1. �Certifique-se de que o cabo USB incluso esteja conectado no seu computa-

dor e no IO 22, que o Mixer esteja aberto e que o IO 22 esteja ligado.

2. �Abra o Cubase LE (localizado na pasta de Aplicativos), e vá para  
Devices>Device Setup (Dispositivos>Configuração de Dispositivo) como 
mostrado abaixo.

3. �Clique em VST Audio System (Sistema de Áudio VST)e selecione 
Lexicon IO 22 como Driver ASIO se ainda não está selecionado.

4. �O Cubase® LE agora irá perguntar se você gostaria de trocar o driver. Sele-
cione Switch (Trocar) e OK.

5. �Verifique se o driver está carregado, clicando em Reset. Depois clique em 
OK.

Apenas para usuários Mac® OS 10.4.x: Após selecionar o Lexicon IO 22 
como o Driver ASIO, você pode precisar verificar que as entradas do seu dis-
positivo estão ativas. Para isso, siga os seguintes passos:
1. �Selecione Device>VST Connections (Dispositivo>Conexões VST) na 

barra de menu.
2. Quando o painel de Conexões VST aparece, clique na aba Entrada.
3. �O box na coluna Dispositivo de Áudio pode mostrar "Not 

Connected"(Não conectado). Se isso acontecer, clique nesta caixa e sele-
cione Lexicon IO 22 para permitir que as entradas IO 22.

4. Feche a janela de Conexões VST.

Agora, você está pronto para iniciar a gravar com o Cubase LE, descrito na 
próxima seção,
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Gravando uma faixa no Cubase® LE
Criando um Novo Projeto
1. �No Cubase, clique em File>New Project (Arquivo>Novo Projeto). A janela 

New Project (Novo Projeto) aparece.
2. �Selecione Lexicon IO 22 Mono In (Entrada Mono Lexicon IO 82) e 

clique em OK.
3. �Selecione a pasta do projeto e clique em Choose (Selecionar).
4. �Adicione uma faixa mono clicando em Project -> Add Track -> Áudio 

(Projeto -> Adicionar Faixa -> Áudio). Escolha a configuração Mono e 
clique em OK.

5. �Na janela Audio 1 o Botão de Gravação  deve aparecer em vermelho. Se 
não está aceso, clique nele para que ele fique vermelho.

6. �Na janela Audio 1, clique no botão Input Monitoring button  de modo 
que não fique aceso.

Certifique-se de que o botão
“Record Enable “ esteja aceso

Certifique-se de que o botão
“Input  Monitoring “ esteja 
apagado

Certifique-se de que o botão
“Record Enable “ esteja aceso

Certifique-se de que o botão
“Input  Monitoring “ esteja 
apagado
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Record Button 
 

 

Stop Button 

Go to Zero Button
 

Play Button

Iniciando a Gravação
1. Clique no botão Record (Gravar) no Controle de Transporte do Cubase® LE.

2. Toque a guitarra.
3. Quando você terminar de gravar, pressione o botão Stop (Parar).

Botão de Gravação

Botão “Stop” (Parar)

Botão “Go to Zero”

Botão “Play” (Tocar)

(Voltar ao Início)

Ouvindo a Gravação
1. No Cubase, clique no botão Go to Zero.

2. Gire o botão Phones (Fones) todo para baixo.
3. Coloque os fones de ouvido.
4. No Cubase, clique no botão Play.

5. �No IO 22, gradualmente, aumente o botão Phones (Fones) até que você 
alcance um nível sonoro confortável.

Uma vez adicionada uma faixa ao seu projeto Cubase, o campo de Roteamen-
to de Entrada será padrão para entrada 1 IO 22. No entanto, se você conectar 
instrumentos em outras entradas para o IO 22, você terá que alterar o Rote-
amento de Entrada para a faixa que quer gravar. Por favor, consulte a tabela 
abaixo para ver como o Roteamento de Entrada no Cubase LE corresponde às 
entradas físicas no IO 22.

Entrada IO 22 
Roteamento de entrada para Faixas Mono no  
Cubase LE (Ao usar o Modelo de Projeto de 

Entrada Mono Lexicon® IO 22)

1 Entrada IO 22 1

2 Entrada IO 22 2
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Mixagem de Áudio
Você pode usar a função de mixagem de áudio no Cubase LE® para criar um 
arquivo .wav do seu projeto Cubase. O arquivo .wav pode então ser gravado 
em um CD ou tocado no reprodutor de mídia do seu computador. O Cubase 
LE não faz mixagem para o formato mp3, no entanto você pode usar outros 
softwares para converter um arquivo .wav para o formato mp3.

Para mixar o seu projeto, primeiro você precisa definir os localizadores es-
querdo e direito; uma maneira de definir os localizadores é pressionar [Ctrl] + 
[A] no teclado do seu computador e depois pressionar [P]. Você também pode 
clicar e arrastar qualquer um dos marcadores para a posição desejada.

Uma vez que os localizadores estejam configurados, vá para “File > Export > 
Audio mixdown” (Arquivo> Exportar > Áudio mixdown). Clique no botão 
‘Choose’ (Escolher) e dê nome ao arquivo no campo ‘File name:’ (Nome do 
arquivo) e selecione o local que você quer salvar o arquivo .wav no campo ‘Look 
in’ (Procurar em) e clique no botão ‘Save’ (Salvar). O arquivo deve primeiro ser 
salvo no disco rígido do seu computador antes de ser gravado em um CD.

A seguir, selecione o Arquivo Wave (.wav) no campo ‘File Format’ (Formato do 
Arquivo), configure a ‘Sample Rate’ (Taxa da Amostra) para kHz, configure a 
'Bit Depth' (Profundidade de Bits) para 16 bit, e clique em “Export” (Exportar).

Opções e Características do Cubase LE
O Cubase LE contém muitas características e opções avançadas para gravação, 
edição e mixagem de áudio. Para saber mais sobre essas características, con-
sulte as seções 'Getting started' e 'Operation Manual' (Iniciando e Manual de 
Operação) encontradas no Cubase LE em ‘Help > Documentation’ (Ajuda> 
Documentação).

Usando a Reverberação Pantheon II no Cubase LE
A reverbação Pantheon II pode ser configurada no Cubase LE de duas maneiras: 
como uma inserção em uma faixa de áudio, ou como uma inserção em um canal FX.

Para usar o Pantheon como uma inserção em uma faixa de áudio:
1. �Verifique se o IO 22 está ligado e conectado ao seu computador (o  

Pantheon II funcionará somente quando um dispositivo IO é detectado).
2. �Clique na aba Inserts (Inserir) no canal em que deseja inserir a reverbera-

ção Pantheon II.
3. �Clique em um slot em branco e escolha Earlier VST Plug-ins > Lexicon 

> Pantheon II (Plug-ins VST Recentes> Lexicon> Pantheon II) Você vai 
ouvir a reverberação Pantheon II só na faixa de áudio em que foi inserida.

Para usar o Pantheon II como uma inserção em um Canal FX:
1. �Certifique-se de que o U82S esteja ligado e conectado no seu computador (o 

Pantheon II só funcionará quando o dispositivo IO é detectado).
2. �Adicione o canal FX. Para isso, vá para Project > Add track > FX Channel, 

(Projeto> Adicionar faixa> Canal FX) e depois clique na aba Inserts (inserir) no 
Canal FX.

3. �Clique em um slot em branco e escolha Earlier VST Plug-ins > Lexicon > 
Pantheon II (Plug-ins VST Recentes> Lexicon> Pantheon II)

4. �Clique na aba Sends (Enviar) para qualquer faixa de áudio que você gostaria de 
usar a reverberação.

5. Clique em um slot em branco e defina a saída para FX-1 Pantheon II.
6. �Clique no botão Power (Ligar) e defina o nível de envio para a posição desejada. 

Qualquer quantidade de faixas de áudio pode enviar sinal para o canal FX.
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Especificações 
Entradas do Microfone:	 Fêmea XLR Pino 2 Hot
Impedância de Entrada:	 3kQ balanceado
Alimentação Fantasma:	 +48 Volts
Ganho Máximo:	 +58 dB
E.I.N. (no ganho máximo):	� -125 dBu @ 58dB ganho típico (fonte 150Ω)
	� -129 dBu @ 58dB ganho típico A-ponderado (fonte 150Ω)

Nível Máximo de Entrada:	 + 21 dBu com ganho mínimo
Resposta da Frequência:	 +0/-1 dB, 20Hz - 20kHz
THD+N:	� <0,006%, 20Hz - 20kHz (entrada do microfone à saída principal) 

	 <0.003%, 1kHz, -6 dBu nível de entrada

Entradas de Linha:	 1/4" TRS balanceado ou não desbalanceado
Impedância de Entrada:	 20kΩ balanceado, 13kΩ não balanceado
Nível Máximo de Entrada:	 +32 dBu
Resposta da Frequência:	 +0/-1.5 dB, 20Hz - 20kHz (referência 1kHz)
THD+N:	� <0,004%, 20Hz - 20kHz (entrada de linha à saída principal)

Entrada do Instrumento:	 1/4" TS não balanceado
Impedância de Entrada:	 1MΩ
Nível Máximo de Entrada:	 +13 dBu
Resposta da Frequência:	 +0/-2 dB, 20Hz - 20kHz (entrada do instrumento à saída principal)
THD+N:	 <0,05%, 20Hz - 20kHz, +4 dBu

Saídas de Linha:	� 1/4" TRS balanceado ou não desbalanceado
Nível:	 >+18 dBu máximo
Impedância:	 32Ω Balanceado, 16Ω Desbalanceado
Saída do Fone de Ouvido:	� Conector estéreo 1/4" 350mW por canal no 50Ω

Interface MIDI:	� 5 pinos conectores DIN para MIDI in e MIDI out (sinal de 5 volt)

Taxas de Amostragem:	� 44.1, 48, 88.2, or 96 kHz (determinado por aplicativo computadorizado)

Alcance Dinâmico:	� A/D (24 Bit) 108 dB típico, A-pesado, 20Hz - 20kHz (44.1 kHz taxa da amostra)
	� D/A (24 Bit) 107 dB típico, A-pesado, 20Hz - 20kHz A/D/A (24 Bit) 102 dB 

tipíco, A-pesado, 20Hz - 20kHz

Requisitos de Energia:	� *NOTA IMPORTANTE: Há dois modelos diferentes do IO 22. Certifique-se de 
que você atende apropriadamente aos requisitos de energia impressos no painel 
traseiro do IO 22 com o modelo de adaptador correspondente listado abaixo.

	 9 VAC 1.3 A 12 W*
	 Adaptadores de energia disponíveis para:
	 Japão	 100 VAC,	 50/60 Hz	 Adaptador: PS0913B - 100*
	 EUA e Canadá	 120 VAC,	 60 Hz	 Adaptador: PS0913B - 120*
	 Europa:	 230 VAC,	 50 Hz	 Adaptador: PS0913B - 230*
	 RU:	 240 VAC,	 50 Hz	 Adaptador: PS0913B - 240*
	 Austrália	 240 VAC,	 50 Hz	 Adaptador: PS0913B - 240-AU*

	 9 VAC 1.3 A 12 W*
	 Adaptadores de energia disponíveis para: 
	 EUA, Canadá, Europa, Japão:	� 100-240 VAC, 50/60 Hz 

Adaptador: PS0913DC-01*
	 Austrália e RU: 100-240 VAC, 50/60 Hz	 Adaptador: PS0913DC-02*
Dimensões: 12” L x 4” A x 3.75” D 
Peso: 2,35 lbs

Os engenheiros Lexicon® estão constantemente trabalhando para melhorar a qualidade dos nossos produtos. Design e espe-
cificações sujeitos a mudança sem aviso prévio.






